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Chapter 3 
Creating and Managing Watersheds 

A watershed is a data set associated with a geographic region for which 
you may have configured multiple models and area coverages.  A 
watershed may include all of the streams, projects (reservoir, levees, etc.), 
gage locations, impact areas, time-series locations, and hydrologic and 
hydraulic data for a specific area.  All of these details together, once 
configured, form a watershed data set. 

In the Watershed Setup Module, you will set up your watershed’s 
physical arrangement including:  background maps, the Stream 
Alignment, geo-extents, projects, and other geo-referenced data. 

You define Configurations when you initially create a watershed.  This 
should enable modelers to develop data explicitly for a specific 
configuration and reduce the possibility that incompatible model data sets 
will be used for multiple program applications (e.g., HEC-ResSim and 
HEC-FIA). 

You can also use the Watershed Setup Module to define Projects and 
Computation Points associated with specific configurations in your 
watershed.  Projects can include Reservoirs, Levees, Diversions, Channel 
Modifications, Off-Channel Storage Areas, and “Other” Projects. 
Computation Points are locations where time-series information is 
exchanged between models (e.g. ResSim and FIA). 

 

3.1 Recognizing Watershed Setup Screen Components 
The Watershed Setup Module provides tools for setting up your 
watershed’s physical arrangement, including maps, the Stream Alignment, 
geo-extents, projects, and other geo-referenced data.  Figure 3.1 shows the 
components of the Watershed Setup Module main window.  Tools unique 
to this module are described in the following sections. 
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Figure 3.1  Watershed Setup Module Main Window 

3.1.1 Menu Bar 
The following is an overview of menus unique to the Watershed 
Setup Module.  These tools will be described in more detail in the 
context of specific tasks later in this chapter. 

Refer to Chapter 2 for information about the View, Tools, and Help 
menus, which are common to all three modules. 

The File menu (Figure 3.2) allows you 
to create a New watershed, Open an 
existing watershed, Save a watershed, 
Save Map (saves the display area) and 
Exit ResSim. Your most-recently-used 
watersheds are located at the bottom of 
the File menu. 

 

 

 
Figure 3.2  File Menu 
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Use the Edit menu (Figure 3.3) to 
access the following editors in the 
Watershed Setup Module: the 
Watershed Data Editor, All Impact 
Areas Editor, Projects Editor, and 
Drawing Properties Editor.  You 
must select Allow Editing if you wish 
to make changes to your watershed (or 
toggle the Lock above the display 
area). 

 

Using the Watershed menu (Figure 
3.4), you can create and edit 
Configurations, Update 
Computation Points, Import and 
Export Stream Alignments, and 
Impact Areas, and Save 
Configurations. 

 

 

The Reports menu (Figure 3.5) 
gives you access to reports for your 
watershed.  Reports include the List 
of Streams, List of Impact Areas, 
List of All Configurations, List of 
Computation Points, and Projects 
listings by project type. 

 

 

3.1.2 Configuration Selector and Lock/Unlock 
When you add a schematic element to the map display, you must 
choose its Configuration using the Configuration Selector.  The 
default Configuration, Study, contains the entire set of all projects and 
Computation Points defined in the watershed.  You can also associate 
projects with custom configurations. 

Before you can add, remove, or edit schematic elements in your 
watershed, you must lock the Configuration by clicking on the  
symbol to the right of the Configuration Selector.  When the 

 
Figure 3.3  Edit Menu 

 
Figure 3.4  Watershed Menu 

 
Figure 3.5 Reports Menu 
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Configuration is locked, the  symbol appears.  If the Configuration 
is unlocked, the  symbol appears. 

3.1.3 Map (Mouse) Tools 
In the Watershed Setup Module, Map (Mouse) Tools allow you to 
access and configure objects within your watershed.  Project Tools 
help you to create and edit the various project types.  After you have 
created a project, ResSim adds it to the active Configuration.  The 
following are descriptions of the available tools: 

 Pointer Tool  
Right-click with the Pointer Tool to select and access a shortcut menu 
for any schematic element in the watershed map display. 

 Zoom Tool 
Use the Zoom Tool to zoom in and out of the display area.  To zoom 
in, hold the left mouse button down and outline the area you want to 
zoom in on.  To zoom out, right-click in the display area. 

 Pan Tool 
Use the Pan Tool to move the display area while you are zoomed in. 

 Time-Series Icon Tool 
Use the Time-Series Icon tools to create, delete, and rename time-
series icons that are used for plotting and tabulating time-series data.  
To create, select the Time-Series Icon Tool, hold down the CTRL 
key and click.  To access the available commands, select the Time-
Series Icon Tool, right-click on a time-series icon, and the commands 
are available from the shortcut menu. 

 Stream Alignment Tool 
Use the Stream Alignment Tool to draw the multi-segmented lines 
that comprise a Stream Alignment representing river systems in the 
map display. 

 Stream Node Tool 
The Stream Node Tool allows you to create and edit stream nodes and 
junctions, two of the primary components of a Stream Alignment. 

 Reservoir Tool 
Use the Reservoir Tool to select and add reservoir projects to the map 
display and access editors for reservoirs. 
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 Levee Tool 
Use the Levee Tool to select and add levee projects to the map display 
panel and access editors for levees.  In the Watershed Setup Module, 
only the name and description can be edited. 

 Diversion Tool 
Use the Diversion Tool to select and add diversions to the map 
display and access editors for Diversions. 

 Channel Modification Tool 
Use the Channel Modification Tool to select and add channel 
modifications (such as channel straightening, concrete walls, 
dredging, and widening) to the map display and access editors for 
Diversions. 

 Off Channel Storage Tool 
Use the Off-Channel Storage Areas Tool to select and create Off-
Channel Storage Area polygons in the map display and edit their 
properties. 

 “Other” Project Tool 
Use the “Other” Projects Tool to place icons representing “other” 
projects, such as pump stations and gages, etc., and edit their 
properties. 

 Impact Area Tool 
Use the Impact Area Tool to create and edit impact areas representing 
regions in the watershed where flood damages will be evaluated. 

 Computation Point Tool 
Use the Computation Point Tool to create and edit Computation 
Points.  Computation Points are locations in the watershed where 
individual models will share information.  Typically one model will 
produce results at a Computation Point that another model will use as 
input. 
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3.2 Using Shortcut Menus 
Shortcut menu commands vary 
according to the schematic 
elements with which they are 
associated.  Figure 3.6 shows the 
shortcut menu for a reservoir 
named “Sayers”. 

If your watershed is locked , 
the shortcut menu will allow you 
to edit, rename, and delete the 
object (depending on the object 
type), as well as view its 
properties.  If your watershed is 
unlocked , some of the options 
will be unavailable. 

3.3 Watershed Creation 
The first thing you must do to create a new watershed is to specify its 
directory location, give it a name and description, and establish the Units 
of Measure and Time Zone.  Once you have created your new watershed, 
ResSim generates a new directory hierarchy in the “base” working 
directory.  Your new watershed becomes active in the main window and 
the tools needed to create the watershed data become available.  At this 
point you may continue to configure the new watershed by adding layers 
and schematic elements, setting preferences for the map display, etc., as 
described later in this chapter. 

3.3.1 Defining a Watershed Location 
A Watershed Location is your working directory--the place on disk 
where you create and edit your watershed data.  You can have 
multiple watershed locations, although an individual watershed 
cannot span multiple locations.  Each watershed location should have 
a logical name, such as CWMS or General Projects. 

Before you can create or open a watershed, you must define at least 
one watershed location.  To define a Watershed Location: 

1. From the Tools menu, select Options.  The HEC-ResSim 
Options dialog box (Figure 3.7) will open. 

Figure 3.6  Reservoir Shortcut Menu  
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Figure 3.7  HEC-ResSim Options Dialog Box 

 
2. Select the Model Directories tab.  The Name and Location of 

any watershed locations you have previously defined will 
display in the list. 

3. To add a new location to the list, click the Add 
Location…button.  The Add Watershed Location dialog box 
will open (Figure 3.8). 

Figure 3.8  Add Watershed Location Dialog Box 

 
4. Enter a logical Name for the new location, then click the 

Browse… button to select the area on disk where you want to 
build your watershed.  This directory is the “holder” of the 
“base” directory and the “base” directory is the “holder” of 
your watershed.  In other words, the Watershed Location 
contains a directory named base, which contains the 
directory(s) for your watershed(s). 

5. Click OK to close the Add Watershed Location dialog box. 

The new location will now appear in the list of watershed locations on 
the Model Directories tab. 

Refer to Appendix A for information about other options available in 
the Options dialog box. 
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3.3.2 Creating a New Watershed 
Once you have established the working directory, you can create a 
new watershed. 

To create a new watershed: 

1. Select New Watershed from the File menu.  The Create New 
Watershed dialog box (Figure 3.9) opens. 

 
Figure 3.9  Create New Watershed Dialog Box 

2. Type a Name for the new watershed.  The watershed name 
must be less than 32 characters and cannot contain any of the 
following characters:  | / : * ? ” < > - \ .   

3. Type a Description for the new watershed that clearly explains 
what it is. 

4. Select a Location (working directory) for the new watershed’s 
directory from your list of available locations. 

5. Specify either English (U.S. customary units) or SI (System 
International) as the Units of Measure.  You will not be able 
to change this after you click OK (see Specifying Units of 
Measure, below, for more information). 

6. Specify the Time Zone of the new watershed by selecting from 
the list of standard time zones.  Note that the watershed Time 
Zone does not recognize Daylight Savings Time (see Section 
3.3.4, Specifying Time Zone, for more information). 

7. Click OK to close the Create New Watershed dialog box. 
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3.3.3 Specifying Units of Measure 
All modeling data, time-series data, geometric and reservoir 
information, model parameters, and flow-, elevation- and stage-time-
series data must use the same unit system when saved.  Therefore, it is 
crucial that you specify either English or SI as the Units of Measure 
for your watershed when you set it up.  NOTE: You cannot change 
the watershed units of measure once the watershed setup is complete, 
but you can at any time customize the display of data using the View 
menu. 

3.3.4 Specifying Time Zone 
When a new watershed is created, the user must select the appropriate 
time zone for the watershed.  This typically would be the time zone 
for the outlet or major portion of the watershed.  Internally, ResSim 
will store all time-series data using the fixed “standard time offset 
from GMT” for the selected watershed time zone.  Thus, internally, 
the data will be held in standard time only. 

 You cannot change the Watershed Units of Measure or the 
Time Zone once the watershed setup is complete. 

3.4 Setting Up New Map Layers 
Layers in ResSim are like transparencies laid one on top of the other, with 
static physical images such as roads, county and state boundaries, rivers, 
subbasins, etc., layered in the display as color pictures.  Each of these 
images, along with its associated data, is a map layer.  Access to the 
Layers Selector is available from the View menu.  Refer to Chapter 4 for a 
more detailed description of Map Layers. 

3.4.1 Importing Maps into ResSim 
The background maps you will use in your watershed will come from 
sources outside of ResSim.  To import a map file for use in your 
watershed, copy the appropriate map files to the “maps” directory of 
your watershed  (see Appendix A for information about the ResSim 
directory structure).  ResSim does not perform coordinate 
transformation for background maps.  Therefore, all of the map layers 
you use in a watershed should be referenced to the same coordinate 
system (see Appendix B for more information on coordinate systems).  
Table 3.1 shows the file formats ResSim supports and each format is 
described in the paragraphs that follow.  Appendix C describes how to 
access the map editors for configuring each type of map format. 
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Table 3.1  Map Layer Formats Supported by ResSim  
Description Common File Name Extension
ArcView® Shapefile .shp 
AutoCAD® DXF .dxf 
Raster image .img, .gif, .jpg 
USGS* Digital Line Graph .dlg 
USGS* Digital Elevation Model .dem 
ASCII NET TIN .net 
ArcInfo® DEM .asc 
*US Geological Survey 

Arc Shapefiles (.shp) 
This layer type is the native data structure for the ArcView® GIS 
program.  Shapefiles store non-topological geometry and attribute 
information for the spatial features of a data set.  Usually there are 
three files:  *.dbf, *.shp, and *.shx.  The .shp file contains the shapes 
(point, polylines, or polygons) that display in the layer.  Each shape 
has a record in the .dbf file containing descriptive data called 
“attributes.”  The .shx file contains an index that links each shape to 
its record in the .dbf file. 

AutoCAD® DXF (.dxf) 
A Drawing Interchange file (.dxf) is created by a Computer-Aided 
Design (CAD) package, AutoCAD®.  This format is a tagged data 
representation of an AutoCad® drawing file.  In tagged data, a group 
code precedes each data element.  A group code is an integer number 
indicating the type of data element.  The file created is a vector-based 
graphic.  The DXF format is commonly used for data exported from 
other CAD and GIS programs. 

Raster Image 
ResSim supports JPEG (.jpg) and Graphics Interchange (.gif) raster 
image formats.  Before ResSim can access these file types, you must 
first create an .img (ASCII text) file containing the following lines: 

Image West=2051443. 
Image North=355443. 
Image East=2054925.6 
Image South=351947.4 
 
 
 
Image URL = path and filename of raster image 

(i.e., maps/lh_2m.gif) 

These are image boundaries that are 
determined by the user and usually 
calculated using a program such as 
ArcInfo®.  

 
The raster image boundaries must match the easting and northing 
parameters stated in the Geographic Region Dialog (see Section 3.4.3, 
“Specifying the Geographic Referencing and Coordinate System”). 
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USGS Digital Line Graph (.dlg) 
USGS Digital Line Graph (DLG) files are created from two sources 
using manual and automated digitizing methods.  The two sources are 
aerial photographs and cartographic sources.  DLG files are vector 
representations of the data.  When ResSim interacts with a .dlg file, it 
automatically creates a .dlgbin file, which is a binary representation of 
the ASCII .dlg file. 

USGS Digital Elevation Model (.dem) 
The USGS Geological Survey publishes the raster file format USGS 
Digital Elevation Model (DEM).  DEM files usually contain terrain 
elevations, but the file format can be used for representing any 
surface.  The format, published by the USGS, allows internal 
documentation of coordinate system, date of publication, etc. 

ASCII NetTin (.net) 
This is an ASCII file format used to represent a Triangulated Irregular 
Network (TIN).  The TIN data is stored in a simple format that 
defines the nodes, edges, and triangles contained in the TIN.  This 
format is common for transferring TIN data between software 
packages. 

ArcInfo® DEM (.asc) 
This is an ASCII file format representation of a grid generated by 
ArcInfo®.  The file consists of keywords followed by values defining 
the number of columns, number of rows, lower left corner, cell size, 
no data value, and each cell value. 
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3.4.2 Adding a New Map Layer 
To make map files accessible 
in the watershed, first make 
sure that the map files are in 
the “maps” directory of the 
watershed, as previously 
described in Section 3.4.1.  
Also, ensure all maps you add 
to a watershed share the same 
coordinate system before you 
add them to the watershed. 

To add a map layer to your 
watershed: 

1. Select Layers from the 
View menu.  The Layer 
Selector dialog box will 
appear (Figure 3.10). 

2. From the Edit menu, 
select Allow Layer 
Editing. 

3. Next, from the Maps 
menu, select Add Map 
Layer.  The Open File 
dialog box (Figure 3.11) 
will open. 

 

Figure 3.11  Open File Dialog Box to Add Map Layer 

 

Figure 3.10  Layer Selector Dialog 
Box 
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4. Locate the map file you wish to use on your local computer (for 
example, “raingage.shp”). 

5. After you have selected the map you wish to use, click OK.  The 
new map will now appear in the Layer Selector dialog box. 

3.4.3 Specifying the Geographic Referencing and 
Coordinate System 

To maintain a geographic reference, you must specify a coordinate 
system for each watershed.  To establish the grid size and coordinate 
system: 

1. Select Layers 
from the View 
menu to open the 
Layer Selector 
dialog box. 

2. From the Maps 
menu, select       
Map Display 
Coordinates to 
open the 
Geographic 
Region dialog 
box (Figure 
3.12). 

The Geographic Region dialog box includes the following 
information: 

Coordinate System 
This box identifies the coordinate system established for the 
watershed.  The coordinate system can be edited, but remember that 
all maps and data must exist in one unified coordinate system.  
Therefore, some layers or data might require the use of a GIS program 
to transform coordinate system information.  For additional 
information about editing the Coordinate System, see “Editing the 
Coordinate System” below. 

Extents 
The values of Easting Min, Easting Max, Northing Min, and 
Northing Max indicate the location of the left, right, bottom and top 
borders (respectively) of the grid in the display area.  ResSim displays 
coordinates in the Status Bar as you move the cursor within the map 
display panel. 

Grow to Map Extents 
When you check this box, ResSim automatically sets the geographic 
region to define the smallest rectangle that encompasses all of the 

 
Figure 3.12  Geographic Region Dialog Box 
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objects (maps, icons, alignments, etc.) in the display area.  If you add 
any objects to the watershed that lie outside the geographic region, 
ResSim automatically updates the extents to include the new objects. 
 

 You must select the geographic extents of your watershed 
carefully to ensure that all layers in your watershed setup 
are included.  The extents you specify and the coordinate 
system you use must be consistent for all layers in the 
watershed.  You should use GIS tools to transform layers 
from one coordinate system to another before you use them 
in ResSim. 

  

Setting Map Coordinates to Display 
You can automatically set the geographic extents to the coordinates in 
your current view.  First, zoom in or out in the display area to 
determine a preferred geographic region, then open the Geographic 
Region dialog box and click Set Map Coordinates to Display.  
ResSim will set the extents to the current view in your map display.  
Objects beyond the geographic extents remain in the watershed, but 
they are not included in the grid of the display area. 

Editing the Coordinate System 
You can edit the Coordinate System of the Watershed by selecting 
Edit in the Geographic Region dialog box.  This opens the Map 
Coordinate Information dialog box, where you can configure the 
System, Units, Spheroid, and other system-specific data.  See 
Appendix B for more information on configuring map coordinate 
information. 


